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	 ไม่ว่าโลกจะเปล่ียนไปขนาดไหน ชีวิตเรา Live ได้ตลอดเวลา แต่กาลเวลาไม่ได้ท�ำให้ซอฟต์แวร์

อย่าง Excel ล้าสมัยลงเลย เรายังคงใช้ Excel ในการท�ำงานอยู่ทุกวันเพื่อเก็บข้อมูล สร้างตาราง

ค�ำนวณ รวมถึงการพรีเซนต์ข้อมูลงานก็ท�ำได้ด้วย ถามว่าแล้วเราจะใช้ Excel กันถึงตอนไหน 

เพราะตลอด 20 กว่าปีที่ผ่านมาก็ไม่มีโปรแกรมสเปรดชีตตัวไหนที่จะมาแทนที่ Excel ได้เลย

ค่ะ จนมาถึงเวอร์ชันล่าสุดนั่นคือ Excel 2019 ส�ำหรับคนที่ใช้งาน Office 365 ก็ไม่ต้องกังวลกับ

เวอร์ชันนะคะ เพราะทุกครั้งที่มีการอัพเดต คุณจะได้อัพเดตเป็นเวอร์ชันล่าสุดโดยไม่เสียเงินเพิม่

	 แล้ว Excel เล่มน้ีล่ะมีอะไรให้คุณอ่านได้บ้าง ต้องขอบอกก่อนนะคะว่าผู้เขียนได้เขียนแบบ 

เน้นทิป เทคนิค และการใช้งานที่จ�ำเป็น เหมาะส�ำหรับท่านที่เคยมีพื้นฐานใช้งาน Excel มาบ้าง

แล้ว และได้เพิ่มการเขียนโค้ด VBA เพื่อเพิ่มประสิทธิภาพการใช้งาน Excel ได้สูงสุด แต่ท่านที่ 

ใช้ Excel ไม่เป็นหรือมือใหม่ก็สามารถท�ำตามและใช้งานได้ค่ะ เพราะมีข้ันตอนการท�ำงานที ่

ชัดเจนเข้าใจง่าย จะแนะน�ำวิธกีารท�ำงาน การจดัการกบัข้อมูลทีท่�ำให้คณุใช้งานได้สะดวกรวดเร็ว

แบบมืออาชีพ Excel จึงเป็นมากกว่าเครื่องคิดเลข เราจึงน�ำมาใช้งานได้หลากหลายมากๆ ลอง

น�ำไปใช้งานดูนะคะ จะท�ำให้คุณสนุกกับการท�ำงานได้มากขึ้นค่ะ ขอบคุณที่เลือกใช้หนังสือเล่มนี ้

นะคะ หวังว่าเนื้อหาต่างๆ ที่น�ำเสนอจะช่วยให้คุณท�ำงานได้ง่ายขึ้น (^.^) 
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กว่าหนังสือเล่มน้ีจะเสร็จก็ใช้เวลานานมาก บ.ก. ทวงแล้วทวงอีกจนเบื่อ ตอนแรกคิดว่าจะ

เสร็จทันตามก�ำหนดเดิม แต่ติดที่ช่วงปลายปีที่แล้วแม่บังเกิดเกล้ามีปัญหาทางด้านสุขภาพ ต้อง

เดินเข้าออกโรงพยาบาลเป็นว่าเล่น ตั้งแต่เดือนตุลาคมจนถึงเดือนธันวาคม จนแม่ผ่าตัดและหาย

ป่วยอย่างปลอดภัย ต้องขอบพระคณุส่ิงศกัด์ิสิทธิแ์ละพระพุทธคณุทีแ่ม่ได้ต้ังจติสวดมนต์ น่ังสมาธิ

ถวายในทกุๆ วัน ท�ำให้ทกุอย่างผ่านไปด้วยดี ขอบคณุเพ่ือนทกุคนทีอ่วยพรและให้ก�ำลังใจมาตลอด 

ขอบคุณน้องจ๋า (ปวีณา) ที่ยกคอนโดให้เป็นที่พักพิงเพ่ือเก็บตัวป่ันงานตลอดเดือนมกราคม 

แต่ต้องไปเผชิญชะตากรรมช่วงทีก่รุงเทพฯ อยู่ในสภาวะอากาศแย่สุดๆ กับฝุ่นละอองขนาดเล็ก 

PM 2.5 ท�ำให้ได้เก็บตัวอยู่ในห้องท�ำงานจริงๆ เพราะเปิดประตูหน้าต่างแทบไม่ได้ ขอบคณุเพ่ือนๆ 

ที่น่ารักทุกคน ขนาดเราบอกว่าไม่ค่อยว่าง แต่ทุกคนก็อยากจะมาหา มาเล้ียงข้าว เล้ียงกาแฟ 

น่ารักจริงๆ สุดท้าย 1 เดือนในกรุงเทพฯ งานไม่เสร็จ ต้องกลับมาปั่นต่อที่เชียงใหม่ แต่ก็กลับมา

เจอเหตุการณ์เดียวกับกรุงเทพฯ เพราะเชียงใหม่ตกอยู่ในสภาวะอากาศที่อึมครึมไปด้วยหมอก

ควันปกคลุมทั้งจังหวัด ค่า PM 2.5 ติดอันดับโลก ออกไปไหนมาไหนก็ไม่ได้ หายใจล�ำบาก กว่า

จะปิดเล่มได้นะคะเหนื่อยสุดๆ กับอุปสรรครอบด้าน ขอบคุณส�ำนักพิมพ์ IDC ที่จัดพิมพ์หนังสือ

เล่มนี้ ขอให้ขายดีๆ นะคะ 

ดวงพร (ต๋อย) 

จากใจนักเขียน
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Microsoft Excel หรือ Excel เป็นโปรแกรม

สเปรดชีต (Spreadsheet) ที่ได้รับความนิยมในการ

ใช้งาน ในลักษณะเหมือนสมุหบัญชี มีตารางในการ

จัดเก็บข้อมูลที่ง่าย สร้างสูตรค�ำนวณเก่ง จัดรูปแบบ

เอกสารได้หลากหลาย วเิคราะห์ข้อมลูได้ดเียีย่ม จึงน�ำ 

ไปใช้ตามส�ำนักงานทั่วไป ในปัจจุบันได้พัฒนามาถึง

เวอร์ชัน Office 2021 และในชุดแอพ Office 365 ซึ่ง

ตอนหลังได้เปล่ียนช่ือมาเป็น Microsoft 365 ใช้งาน

ในรูปแบบของ Subscription ที่ผู้ ใช้ต้องจ่ายค่าบริการ

เป็นรายเดือน หรือรายปี โดยเลือกประเภทตามความ

เหมาะสมกับการใช้งาน สามารถอัพเดตการท�ำงาน 

และอัพเกรดเวอร์ชนัได้ตลอดโดยไม่เสียค่าใช้จ่ายเพิม่ 

ท�ำให้โปรแกรมทันสมัยอยู่เสมอ

Lesson

ในบทน้ีจะแนะน�ำการใช้งานพ้ืนฐานเบื้องต้น

ส�ำหรับคนที่ยังไม่คุ้นเคยกับการท�ำงาน Excel หรือ

ต้องการทบทวนการท�ำงานเพ่ือน�ำไปใช้งานต่อในบท

อื่นๆ ที่เน้นเทคนิคการใช้งานเป็นเรื่องๆ ไป 

พ้ืนฐาน Excel เบื้องต้น00
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2 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

เปิดโปรแกรม Excel
เม่ือเปิดโปรแกรม Excel เข้ามาคร้ังแรก โปรแกรมให้เลือกว่าต้องการเร่ิมต้นสร้างสมุดงาน หรือเวิร์กบุก๊แบบไหน 

ซึง่จะมีทัง้เวิร์กบุก๊เปล่ามีแต่หน้า Worksheet ว่างๆ และเวิร์กบุก๊แบบเทมเพลต ทีมี่การวางโครงสร้างพ้ืนฐานของเน้ือหา

และจัดรปูแบบเบื้องต้นเอาไว้ ซึ่งคุณสามารถน�ำมาใช้งานได้เลย โดยน�ำมาปรับปรงุเนือ้หาให้เป็นงานของคุณเอง หรอื

จะเลือกเป็น Blank workbook สร้างเวิร์กบุ๊กว่างๆ 

�� การเลือก Blank workbook จะไดเ้วิรก์บุก๊ใหมช่ือ่ Book1 และมี Worksheet วา่งๆ มาให้ 1 เวิรก์ชตี (ตัง้คา่จ�ำนวน
เริม่ตน้ หรือเพ่ิมจ�ำนวนเวริก์ชตีภายหลงัไดต้ามตอ้งการ)

เลือกเวิร์กบุ๊กว่าง Blank workbook

เวิร์กบุ๊กว่างในชื่อ Book1
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3Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

Excel เมนูภาษาไทย
การท�ำงานกับ Excel เมนูภาษาไทยจะเลือกสลับเมนูได้ถ้ามีการติดต้ังภาษาไทยแล้ว ซึ่งการท�ำงานต่างๆ จะ

ท�ำได้เหมือนภาษาอังกฤษแต่จะส่ือสารด้วยเมนูภาษาไทย ส่วนการใส่สูตรค�ำนวณหรือฟังก์ชันต้องใช้ตามโครงสร้าง

ภาษาอังกฤษมาตรฐาน

�� หากมีการเช่ือมตอ่กับอนิเทอรเ์น็ตแลว้เปิดโปรแกรมเข้ามา หรอืใชค้�ำสัง่ New ในหนา้เริม่ตน้จะแสดงคา่เริม่ตน้แบบออนไลน์ 
(Online) จะมเีทมเพลตหนา้ตาแปลกๆ เพ่ิมเข้ามา ซึง่เป็นเทมเพลตออนไลน์ท่ีโหลดมาจากเวบ็ Office.com ท�ำให้คณุ
สามารถเลอืกเทมเพลตตวัอยา่งไดห้ลากหลายรปูแบบมากข้ึน

Excel ภาษาไทย เริ่มต้นเลือกเทมเพลต

เทมเพลตออนไลน์จากอินเทอร์เน็ต
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4 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

�� Active cell คือ ต�ำแหน่งเซลล์ที่คลิกหรือเลือก 

ใชง้านปจัจบุนั ดูจากเสน้ขอบหนาๆ รอบเซลล์

�� Formula bar แถบสตูรค�ำนวณทีใ่ชส้�ำหรบัใสสู่ตร 
แกไ้ข และแสดงสูตรของเซลล์ทีเ่ลอืก

�� Row (แถว) พ้ืนท่ีของแถวแนวนอนจากบนลงลา่ง 
เริม่จากแถวที ่ 1 ไปจนถงึแถวที ่ 1,048,576 รวม
ทัง้หมดล้านกวา่แถว

�� Column (คอลัมน)์ พ้ืนทีข่องคอลมัน์แนวตัง้จากซา้ย
ไปขวา เริม่จากคอลมัน์ A ไปจนถึงคอลมัน์ XFD รวม
ทัง้หมด 16,384 คอลมัน์

�� Cell (เซลล)์ คอืชอ่งตารางทีเ่ป็นจดุตดัระหวา่ง Row 
และ Column ซ่ึงจะเรียกชือ่เซลลจ์ากชือ่คอลัมนต์าม
ดว้ยหมายเลขแถว เชน่ จดุตดัทีค่อลมัน ์C ในแถว 

ที ่9 จะเรยีกวา่ เซลล์ “A9” เป็นตน้

�� Name Box (กลอ่งชือ่) แสดงชือ่เซลลท่ี์เลอืกและชือ่
เซลลท่ี์ก�ำหนดข้ึนมาใหม ่เม่ือคลกิในเซลลใ์ดจะแสดง
ชือ่เซลลใ์นช่องน้ี และสามารถใสช่ื่อเซลลเ์พ่ือกระโดด
ไปยงัเซลลท่ี์ตอ้งการได้

�� Sheet Tab คอืปา้ยชือ่ของเวริก์ชตี เริม่แรกเม่ือ
สร้างเวิร์กบุ๊กเข้ามาใหม่จะมีแค่ 1 เวิร์กชีต คือ 
Sheet1 สามารถเปลี่ยนเพ่ิมจ�ำนวนชีตใหม่ได้โดย
คลกิท่ีปุม่  เพ่ิมชตีได้ตามตอ้งการ

�� กดปุม่  + ลกูศร  เพ่ือเล่ือนไป 

ต�ำแหน่งสดุทา้ยหรอืต�ำแหนง่แรกของแถวและคอลมันไ์ด้

ชื่อชีต ใส่สีแท็บชีต เพ่ิมชีตใหม่ เลื่อนหน้าจอซ้าย/ขวา ย่อ/ขยายหน้าจอเลื่อนไปยังชีตต่างๆ

สูตร/ฟงัก์ชัน

คอลัมน์ (Column)

แถว (Row)

แถบสูตรค�ำนวณ (Formula bar)

คลิกขยายแถบสูตรแอคทีฟเซลล์ (Active Cell)

ส่วนประกอบของ Worksheet (เวิร์กชีต)
ใน 1 Workbook จะมี Worksheet (จะเรียกสั้นๆ ว่า ชีต) เป็นพื้นที่ในการเก็บข้อมูล จะมีชื่อเรียกส่วนประกอบ

ต่างๆ ดังนี้

กล่องชื่อเซลล์
(Name Box)
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5Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

สร้างเวิร์กบุ๊กจากเทมเพลต (Template)
การสร้างเวิร์กบุ๊กจากเทมเพลตจะมี 2 กรณี คือ ไม่ได้เชื่อมต่ออินเทอร์เน็ตก็จะเลือกได้บางส่วน แต่ถ้าเชื่อมต่อ

อินเทอร์เน็ตเอาไว้ เวิร์กบุ๊กเทมเพลตจะมีให้เลือกมากมายหลายรูปแบบ โดยจะมีอยู่ในเว็บไซต์ Office.com หาก 

เลือกเทมเพลตแบบใดก็จะดาวน์โหลด (Download) เทมเพลตมาแสดงในเวิร์กบุ๊ก จากนั้นคุณก็บันทึกเก็บไว้ใช้งาน

ต่อได้ ซึ่งบางเทมเพลตก็จะมีตัวอย่างข้อมูลและสูตรการค�ำนวณมาให้ด้วย

คลิกเลื่อนไปดูเทมเพลตก่อนหนา้ ดูตัวอย่างเทมเพลต คลิกเลื่อนไปดูเทมเพลตถัดไป

หรือคลิกเลือกประเภทของเทมเพลต

คลิกสร้าง (Create)3

คลิกเลือกรูปแบบของเทมเพลตที่จะใช้2

คลิกเมนู File (แฟม้) เลือกค�ำสั่ง New (ใหม่)1
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6 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

�� เมือ่คลกิทีปุ่ม่ Save บันทกึเวริก์บุ๊กแลว้กเ็ลอืกวา่จะบนัทึกเกบ็ไฟล์เอกสารไวท่ี้ไหน โดยปกต ิOffice 365 จะตัง้คา่
การบนัทกึเอาไวท้ี ่ OneDrive แตถ่า้คณุจะบนัทกึไวท้ีอ่ืน่กเ็ลอืกไดรวแ์ละโฟลเดอรท์ีจ่ะเกบ็ได ้ ให้ดรูายละเอยีดเพ่ิมเตมิ
ในหวัขอ้ "การบันทกึเวริก์บุ๊ก"

ชีตตัวอย่างจากเทมเพลต ข้อมูลตัวอย่างจากเทมเพลต

โฟลเดอร์ที่เคยเปิด/บันทึกไฟล์

ประเภทของ
ไฟล์ Excel 

คลกิบนัทกึเวิรก์บุก๊4

เวิร์กบุ๊กใหม่ที่สร้างจากเทมเพลต

เลือกต�ำแหน่งที่จะบันทึกไฟล์5 ตั้งชื่อไฟล์ แล้วคลิกปุม่ Save6
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7Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

�� กดปุม่  +  หรอืกดปุม่  +  +  
เพ่ิมชตีไดแ้บบรวดเร็ว

เพ่ิมเวิร์กชีตใหม่ (New Worksheet)
การเพิ่มจ�ำนวนชีตในการเก็บข้อมูล เพื่อแยกประเภทข้อมูลให้เป็นหมวดหมู่ จะได้เข้าถึงและจัดการข้อมูลได้ง่าย 

เหมือนเรามีสมุด 1 เล่ม มีจ�ำนวนหน้าเป็นร้อยแล้วจะเขียนข้อมูลแยกไว้ในหน้าไหนนั่นเอง

คลิกเพ่ิมชีตได้ตามต้องการ

คลิกขวาบนชีต เลือก Insert คลิกเพ่ิมชีต

เวิร์กชีตใหม่ที่เพิ่มเข้ามา
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8 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

ตัง้ค่าการสร้างเวิร์กชีตในเวิร์กบุ๊กใหม่
คุณสามารถตั้งค่าเริ่มต้นเมื่อสร้างสมุดงานใหม่ (Workbook) ได้ ว่าจะให้เวิร์กชีตเริ่มต้นกี่ชีต และให้ตัวอักษรมี

ขนาดเท่าไหร่ ดังนี้

1	 คลิกเมนู  แล้วคลิกเลือก Options

2	 ในแท็บ General ก�ำหนดค่าเริ่มต้นต่างๆ ได้ดังนี้

�� ในหวัขอ้ User Interface options 

�� Show Mini Toolbar on selection ใหแ้สดงแถบเครือ่งมือขนาดเลก็เม่ือเลือกข้อมูลในเซลล์

�� Show Quick Analysis option on selection แสดงตวัเลอืกการวเิคราะห์อยา่งรวดเรว็เม่ือเลือกเซลล์

�� Enable Live Preview เปิดใหแ้สดงตวัอยา่งเม่ือใช้ค�ำสัง่ หรอืจดัรปูแบบกอ่นเลอืกใชห้รอืไม่

�� ในหวัขอ้ When creating new workbooks ดงัน้ี 

�� Use this as the default 
font เลอืกใชฟ้อนตเ์ริม่ตน้

�� Font size เลอืกขนาดตวัอกัษร

�� Default view for new sheet 
เลอืกมุมมองส�ำหรบัแผ่นงานใหม่

�� Include this many sheets 
ก�ำหนดจ�ำนวนชีตเริ่มต้น เม่ือ
สรา้งสมดุงานใหม่

�� ในหวัข้อ Personalize You copy... 
จะก�ำหนดการแสดงผลของโปรแกรม
ซึ่งจะมีผลกับโปรแกรมทุกตัวในชุด 
Office

�� User name ก�ำหนดชือ่ผูใ้ช้

�� Office Background เลือก
รปูแบบสพ้ืีนหลงัของโปรแกรม

�� Office Theme เลือกชุด
ลวดลายของออฟฟศิธมี

�� ในหวัขอ้ Start up options ดังนี้ 

�� Show the Start screen when this applications start ให้แสดงหน้าจอเริม่เม่ือเปิด Excel เข้ามา
ใหมทุ่กครัง้
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9Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

ติดตัง้เมนูภาษาไทย/อังกฤษเพ่ิม
ปกติภาษาของชุด Office จะเริ่มจากภาษาใดภาษาหนึ่งที่ติดตั้งครั้งแรก เช่น ภาษาไทย ก็จะมีแต่ภาษาไทย หรือ

ถ้าติดตั้งภาษา English ก็จะมีแต่ภาษาอังกฤษ หากต้องการให้แสดงภาษาอื่นๆ ก็สามารถคลิก Add Language เพิ่ม

ได้ เช่น Thai, Japan หรือ China ได้ตามต้องการ

คลิกเมนู File (แฟม้) เลือก Options - Language (ภาษา)1

เลอืกภาษา2

คลิกปุม่ Install 3

ตรวจสอบการอพัเดต4 คลิกปุม่ OK5
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10 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

ข้อความแจ้งเตือนการเริ่มดาวน์โหลด

แจ้งเตือนให้บันทึกงานก่อนปิด

คลิกเพ่ิมภาษาเขียน/
แก้ไขเอกสาร

เริ่มท�ำการดาวน์โหลด7

คลิกปุม่ Yes6

คลิกปุม่ Continue8

ติดตั้งเสร็จแล้วจะเริ่มปิดแอพ9

เริ่มเปลี่ยนภาษาที่ติดตั้งเพิ่มอัตโนมัติ ภาษาที่ตดิตั้งเพ่ิม10

คลิกปุ่ม ตกลง11
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11Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

เลือกภาษาส�ำหรับสรา้ง, แก้ไข และตรวจสอบค�ำสะกด

�� ในหวัขอ้ Office authorings languages and proofing จะเลอืกภาษาในการแสดงผลของเอกสาร หรอืใช้เปิด
เอกสารในภาษาตา่งๆ ทีไ่ดรั้บเพ่ือสามารถแกไ้ขหรอืตรวจสอบค�ำสะกดได้

เปลีย่นเมนูไทย/English
ถ้าคุณได้ติดตั้งชุดภาษา Display Language เพื่อใช้สลับภาษาแสดงผลในหน้าจอได้แล้วก็เลือกเปลี่ยนภาษาของ

เมนูและค�ำสั่งเป็นภาษาไทยหรืออังกฤษสลับกันได้ การเปลี่ยนภาษาการท�ำงานของโปรแกรมในชุด Office 2019 นี้

สามารถเปล่ียนได้จากโปรแกรมใดๆ ในชุดซึ่งจะมีผลกับทุกโปรแกรมที่ใช้งานอยู่ เช่น ขณะน้ันใช้ภาษาอังกฤษอยู่ 

แล้วเปลี่ยนเป็นภาษาไทยจากโปรแกรม Excel หากคุณปิด Excel แล้วเปิดขึ้นใหม่ก็จะแสดงผลภาษาไทย แต่ถ้าเปิด

โปรแกรม Word ค้างอยู่แล้วไม่ได้ปิด ก็ยังคงใช้ภาษาอังกฤษต่อได้เหมือนเดิมจนกว่าจะปิด Word แล้วเปิดกลับเข้า 

มาใหม่จึงจะเปลี่ยนเป็นภาษาไทยให้ การเลือกภาษาในโปรแกรมท�ำได้ดังนี้

�� ในหวัขอ้ Office display Language จะเลอืกภาษาในการแสดงผลในหน้าจอ เชน่ เมนู, ค�ำสัง่ และปุม่ตา่งๆ ตามภาษา 
ทีเ่ลอืก 

�� Match Microsoft Windows [English] ใชภ้าษาเดยีวกบัระบบ Windows เชน่ Windows ภาษาองักฤษ Office 
กใ็ชภ้าษาองักฤษด้วย

�� การเปล่ียนภาษาใน Excel จะมผีลกบัแอพทกุตวัในชดุ Office เชน่ Word, PowerPoint หรอื Access

คลิกปุม่ OK4

คลิกเมนู File (แฟม้) เลือก Options - Language (ภาษา)1

คลิกบันทึกเวิร์กบุ๊ก2

คลิกปุม่ Move Up3
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12 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

�� การสลบัเมนกูารท�ำงานภาษาไทยหรอืองักฤษจะท�ำไดว้ธิเีดยีวกนั เพียงแคเ่ลอืกสลบัภาษาทีจ่ะใชข้ึน้ดา้นบน  เมือ่คลกิ OK 
(ตกลง) แล้ว ตอ้งปิดโปรแกรม Excel แลว้เปิดเขา้มาใหม่ ภาษากจ็ะแสดงตามท่ีเปล่ียน แตถ่า้เลอืกแลว้กจ็ะใชภ้าษาเดมิ
ตอ่ได ้จนกวา่จะปิดและเปิดโปรแกรมเขา้มาใหม่

เลือกแสดงผลเมนูภาษาไทย

Excel เมนูภาษาไทย
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13Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

Keyboard Shortcut กดแปน้คีย์ลัด
การท�ำงานกับข้อมูลแบบรวดเร็ว ถ้าเราพิมพ์งานอยู่จะใช้งานค�ำสั่งที่ใช้บ่อยๆ ไม่ต้องไปจับเมาส์หรือคลิกหน้าจอ

ให้เสียเวลา สามารถกดปุ่มบนแป้นพิมพ์ที่เราเรียกว่า Keyboard Shortcut Key โดยเลือกกดใช้งานหรือเข้าถึงค�ำสั่ง 

ได้แบบรวดเร็ว ซึ่งจะมีปุ่มคีย์ลัดที่ใช้งานบ่อยๆ ดังนี้

ปุม่ ค�ำสั่ง รายละเอียด

 + create a new workbook สร้างเวิร์กบุ๊กใหม่

 + open an existing workbook เปิดไฟล์เวิร์กบุ๊ก

 + save a workbook บันทึกไฟล์เวิร์กบุ๊ก

 + close the current workbook ปิดเวิร์กบุ๊กที่ท�ำงานอยู่

 + close Excel ปิดโปรแกรม Excel

 + move to the next sheet เลื่อนไปที่ชีตถัดไป

 + move to the previous sheet เลื่อนไปที่ชีตก่อนหน้า

 + go to the Data tab เปิดไปที่แท็บ Data (ข้อมูล)

 + go to the View tab ไปที่แท็บ View (วิว) 

 + go to the Formula tab ไปที่แท็บ Formula (สูตร)

 + go to Insert tab ไปที่แท็บ Insert (แทรก)

 + go to File tab ไปที่แท็บเมนู File

 +  + go to Options เปิดหน้าต่างตัวเลือก 

 + Copy ก็อปปี้เซลล์, ข้อมูล, ออบเจ็กต์

 + Cut ตัดเซลล์, ตัดข้อมูล

 + Paste วางข้อมูลที่ copy หรือ cut ไว้

 + Bold จัดรูปแบบตัวหนา

 +  หรือ 

 +  + 

Open Shortcut menu เปิดเมนูลัด

 +  + Move rigth to end cell เลื่อนไปที่ข้อมูลรายการสุดท้ายขวา

 +  + Open Format Cells Font เปิดหน้าต่างจัดรูปแบบฟอนต์

 + Select All Cells Range คลิกในเซลล์จะเลือกกลุ่มเซลล์ข้อมูลติดกนั หรือคลิก

เซลล์ว่างจะเลือกทั้งชีต

 +  Start a new line ขึ้นบรรทัดใหม่ในเซลล์เดียวกัน
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14 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

แทรกคอลัมน์ (Insert Column)
หลังจากเก็บข้อมูลลงในคอลัมน์ไปแล้ว หากต้องการเพ่ิมคอลัมน์ว่างก็คลิกที่ช่ือหัวคอลัมน์แล้วคลิกขวาเลือก 

ค�ำสั่ง Insert ได้ โดยคอลัมน์ใหม่ว่างๆ จะแทรกเข้ามาทางซ้าย

�� การเลือกคอลมัน ์ ถา้คลกิจะเลอืก 1 คอลมัน ์ คลกิลากจะเลอืกหลายๆ คอลมัน์ตดิกนั หรอืใชปุ้ม่  และ 
มาชว่ยในการคลกิเลอืกได้

คลิกขวาบนคอลัมน์แล้วเลือกค�ำสั่ง Insert (แทรก) 

เลือกการจัดรูปแบบคอลัมน์ตามคอลัมน์ซ้ายหรือขวา

คอลัมน์ใหม่ที่แทรกเข้ามา
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15Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

คลิกขวาหนา้หมายเลขหัวแถว เลือกค�ำสั่ง Insert (แทรก) 

เลือกการจัดรูปแบบของแถวตามด้านบนหรือด้านล่าง

แทรกแถว (Insert Row)
ข้อมูลในแถวที่มีข้อมูลเก็บต่อเน่ืองไปแล้ว หากต้องการแทรกแถวว่างก็คลิกที่หมายเลขหัวแถวแล้วคลิกขวา 

เลือกค�ำสั่ง Insert จะได้แถวว่างตามจ�ำนวนที่เลือกแทรก

�� การเลือกแถว ถา้คลกิทีห่มายเลขหวัแถวจะเลอืก 1 แถว คลิกลากจะเลือกหลายๆ แถวตดิกนั หรอืใชปุ้ม่  และ 
มาชว่ยในการคลกิเลอืกแถวได้

แถวว่างที่เพิ่มเข้ามา
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16 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

แทรกเซลล์ (Insert Cells)
การแทรกเซลล์จะแทรกตามจ�ำนวนเซลล์ที่เลือก แต่จะเลือกการเล่ือนเซลล์เดิมที่มีข้อมูลไปทางด้านใด เช่น 

เลื่อนไปทางขวา (Shift cells right) หรือเลื่อนเซลล์ลง (Shift cells down)

เลือกการจัดรูปแบบ

แทรกเซลล์วา่งและเลื่อนเซลล์เดิมลงด้านล่าง

แทรกเซลล์ว่างตามจ�ำนวน 
และเลื่อนเซลล์เดิมไปทางขวา

 เลือกเซลล์ แล้วคลิกขวาเลือก Insert (แทรก)1  เลือกการแทรกเซลล์2  หรือคลิกเลือก3

เลือกการ
จัดรูปแบบ
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17Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

ลบคอลัมน์ (Delete Column)

ลบแถว และคอลัมน์ (Delete Row & Column)
การลบแถวจะลบข้อมูลในแถวนั้นทั้งหมดทุกคอลัมน์ทิ้ง ส่วนการลบคอลัมน์จะลบข้อมูลทุกแถวใต้คอลัมน์นั้นทิ้ง 

และจะมีการขยับข้อมูลเดิมที่มีอยู่เข้ามาแทนที่ เช่น ลบแถวจะขยับแถวด้านล่างข้ึนมาแทน ถ้าลบคอลัมน์จะขยับ

คอลัมน์ทางขวาเข้ามาแทน 

ลบแถว (Delete Row)

ขยับคอลัมน์ที่เหลือมาทางซ้ายคลิกเลือกคอลัมน์ เลือกค�ำสั่ง Delete (ลบ) 

คลิกหมายเลขหัวแถว เลือกค�ำสั่ง Delete (ลบ)  หรือคลิกเลือก1
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18 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

ลบเซลล์ (Delete Cells) 
การลบเซลล์จะลบแล้วมีการขยับต�ำแหน่งข้อมูลเดิมทีมี่อยู่เข้ามาแทนที ่ซึง่จะเลือกได้ 2 แบบ คอื Shift cells Left 

เลื่อนข้อมูลทางขวาเข้ามาแทนที่ และ Shift cells up เลื่อนเซลล์ข้อมูลด้านล่างขึ้นมาแทนที่

เซลล์จะถูกลบทิ้งแล้วเลื่อนไปทางซ้าย

ข้อมูลจะถูกลบทิ้งโดยจะเลื่อนขึ้นไปข้างบน

เลือกเซลล์ แล้วคลิกขวาเลือก Delete... (ลบ)1

เลอืกการลบเซลล์2 หรือคลิกเลือก3
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19Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

การจัดการเวิร์กชีต
ในส่วนนี้จะเป็นการแนะน�ำการท�ำงานกับเวิร์กชีตในด้านต่างๆ เพื่อสะดวกต่อการท�ำงานให้รวดเร็ว อาทิเช่น การ

ลบชีต, การซ่อนชีต, การย้ายชีต และอื่นๆ

ใส่สีแท็บชีต : Tab Color

ซ่อนชีต : Hide Sheet

ลบชีต : Delete Sheet

�� การใส่สีแท็บชื่อชีตเพ่ือเน้นแยกชื่อชีต 

ให้ดแูตกตา่งและเข้าถงึไดง่้ายยิง่ข้ึน

�� ชตีทีม่ขีอ้มลูทีไ่มต้่องการใหแ้สดงในหนา้จอ
หรือชีตข้อมูลส�ำรองอาจจะซ่อนเอาไว้ก่อน
ไดด้ว้ยค�ำสัง่ Hide 

�� ส�ำหรับชีตข้อมูลหรือชีตว่างที่ไม่ได้ใช้งาน
แล้วจะเลือกลบท้ิงออกไปได้ด้วยค�ำส่ัง 
Delete แตก่ารลบตอ้งระวงัเพราะจะ Undo 
ยกเลิกค�ำสัง่ลบไมไ่ด้

คลิกขวาบนแท็บชื่อชีต เลือกสี
จากค�ำสั่ง Tab Color

คลิกขวาบนแท็บชื่อชีต เลือก Hide ซ่อน
หรือ Unhide ยกเลิกการซ่อนชีต
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20 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

ก็อปป้ีหรือย้ายชีต : Copy or Move 

เลือกทัง้ชีต : Select All Sheet 

เลือกชีตเป็นกลุ่ม : Group Sheet 
�� โดยปกติการคลกิเลอืกชีตใดเรากจ็ะท�ำงานกบัชีตน้ัน 
หากต้องท�ำงานกับชีตหลายๆ ชีต สามารถใช้ปุม่ 

 และ  มาชว่ยคลกิเลอืกชตีอืน่ๆ เพ่ิมได้ 

�� การเลือกทัง้ชีตจะหมายถงึการเลอืกทุกเซลล,์ ทุกแถว 
และทุกคอลัมน์ในชีต มักจะใช้ส�ำหรับการใช้ค�ำสั่ง
บางอย่างทีต่อ้งการใหม้ผีลทัง้ชตี เชน่ เลือกรปูแบบ
ฟอนต์, ขนาดอกัษร, ปรบัความกวา้งคอลมัน ์ หรือ
ปรบัความสงูแถว เป็นตน้ 

�� หากตอ้งการกอ็ปป้ีชตีเก็บเอาไวใ้นเวริก์บุก๊เดยีวกนัหรอืกอ็ปป้ีไปไวท่ี้เวริก์บุ๊กอ่ืน กเ็ลอืก Create a copy ชตีได ้แต่
ถา้ไมค่ลกิเลอืก Create a copy จะเป็นการยา้ยชตีแทน

คลิกชีตแรก กดปุม่  ค้างไว้ แล้วคลิกชีตอื่นๆ 

คลิกที่หัวมุมชีต

คลิกขวาเลือกค�ำสั่ง Move or copy... 

คลิกเลือก Create a copy ถ้าจะก็อปป้ี

เลอืกเวร์ิกบุก๊

เลือกต�ำแหน่ง 
ที่จะวาง
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21Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

ปรับความสูงแถว : Row Height

ปรับความกว้างคอลัมน์และความสูงของแถว

ปรับความกว้างคอลัมน์ : Column Width
�� การปรบัความกวา้งของคอลมัน์ใหเ้หมาะสมกบัการแสดงขอ้มลู จะคลกิลากปรบั หรอืดบัเบลิคลกิเสน้แบง่คอลมันเ์พ่ือ
ปรบัอัตโนมตัใิหพ้อดกีบัขอ้มลูภายในคอลมันไ์ด้

เลื่อนเมาส์ไปชี้ที่เส้นแบ่งแถว
แล้วคลิกลากลง

หรือเลือกปรับหลายๆ แถว

 เลือกคอลัมน์1  เลื่อนมาชี้ที่เส้นแบ่งคอลัมน์2

  คลิกลากปรับขนาด 3
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22 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

จัดรูปแบบเซลล์ด้วย Format Cells
ข้อมูลทีเ่กบ็ในเซลล์เร่ิมแรกจะแสดงตามค่ามาตรฐานเร่ิมต้น เช่น พ้ืนเซลล์ไม่มีสี (No fill), ไม่มีเส้นขอบ (Border), 

ตัวเลขแบบธรรมดา (General) และข้อความอยู่ชิดซ้าย ตัวเลขอยู่ชิดขวา หลังจากที่ป้อนข้อมูลไปแล้วคุณจะเลือก 

จัดรูปแบบต่างๆ ได้โดยเลือกค�ำสั่งจากกลุ่ม Format หรือเลือกค�ำสั่ง Format Cells  จัดรูปแบบได้

คลิกเปิดหนา้ต่าง 
Format Cells

เลือกจัดรูปแบบจาก 
กลุ่มค�ำสั่งบนแท็บ Home 

�� แท็บ Number จดัรปูแบบตวัเลขในรปูแบบตา่งๆ หรอื
เลอืก Custom สรา้งรปูแบบใหม่

�� แทบ็ Alignment จัดต�ำแหนง่ข้อมลูในเซลล ์ซา้ย, 
กลาง, ขวา หรอืเท่ากนั

�� แท็บ Font จดัรปูแบบข้อความ เลอืกฟอนต,์ ขนาด, สี 
หรอืขีดเสน้ใต้

�� แทบ็ Border จดัรปูแบบเสน้ขอบ เลอืกเสน้, ส,ี ขนาด 
และขอบเขตการแสดงเสน้รอบเซลล์

�� แท็บ Fill เลอืกสพ้ืีนเซลล์, สีเรยีบ, ลวดลาย (Pattern) 
หรอืสีเอฟเฟก็ต ์(Fill Effect)
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23Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

จัดรูปแบบด้วย Cell Styles
การจัดรูปแบบเซลล์แบบรวดเร็วสามารถเลือกรูปแบบจาก Cell Styles (เซลล์สไตล์) ได้ โดยจะมีรูปแบบพื้นฐาน

ให้เลือกหลายแบบ เลือกคลิกใช้งานได้เลย

คลิกปุม่ Cell Styles2

เลอืกกลุม่เซลล์1

 คลิกเลือก Heading 2 3

เลือกกลุ่มเซลล์ และเลือกจัดรูปแบบ 
20% Accent

4
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24 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

เชือ่มโยงบริการ OneDrive
Excel และโปรแกรมในชุด Microsoft 365 จะสนับสนุนการเกบ็ข้อมูลหรือเอกสารเอาไว้ที ่Clouds บนอนิเทอร์เน็ต

ในบริการชื่อ OneDrive เป็นพื้นที่เก็บข้อมูลขนาด 5 GB ฟรี เพื่อให้คุณสามารถเข้าถึงเอกสารได้ทุกที่ทุกเวลาทั่วโลก

โดยที่ไม่ต้องพกพาอุปกรณ์คอมพิวเตอร์หรือไดรว์ใดๆ ก็เปิดดูและแก้ไขเอกสารได้ นอกจากจากน้ีคุณยังสามารถ 

แชร์เอกสารให้กับผู้อื่นหรือเพื่อนร่วมงานได้อย่างง่ายดาย (ส�ำหรับท่านที่สมัครใช้งาน Microosft 365 แบบรายเดือน

หรือรายปีจะได้พื้นที่ขนาด 1 TB) 

หากยังไม่มีชื่ออีเมล คลิก Create one ไปสมัครใหม่ได้

เลือกเมนู File -> Acccount และคลิก Add a service -> OneDrive1

กรอกชื่ออีเมล และ Next ไปใส่รหัสผ่าน2
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25Lesson 00 : พ้ืนฐาน Excel เบื้องต้น

�� หลังจากท่ีเชือ่มโยงเข้ากบัชือ่บญัชขีอง OneDrive 
ไดเ้รียบรอ้ยแล้ว คณุสามารถเกบ็บันทึกงานเอกสาร
ไวท่ี้ OneDrive ได ้โดยเลือกค�ำสัง่ Save As แลว้
เลอืกเป็น OneDrive Personal เพ่ือบนัทึก

�� ใน OneDrive คุณจะสร้างโฟลเดอร์เก็บเอกสาร, 
รปูภาพ หรอืวิดโีอ และไฟลอ์ืน่ๆ ข้ึนไปเกบ็ และเพ่ือ
น�ำมาแชรไ์ดอ้ยา่งง่ายดาย 

�� บน Windows 10, Windows 11 จะมีแอพชื่อ 
OneDrive ให้คุณเข้าไปจัดการกับไฟล์ได้เหมือน
หน้าตา่งไฟลท่ี์ใชง้านในเครือ่งฯ 

เลือกบันทึกเอกสารเก็บไว้บน OneDrive ได้

แสดงที่จัดเก็บอยู่ใน OneDrive

หลังเพิ่ม OneDrive

เมื่อคลิกปุ่มชื่อไฟล์
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26 คู่มือใช้งาน Excel 365 ฉบับสมบูรณ์

ใช้งานผ่านเว็บบราวเซอร์

ใช้งานผ่านแอพ

ไฟล์ต่างๆ ที่จัดเก็บเอาไว้
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โดยปกติการน�ำเข้าข้อมูลลงใน Excel จะมีการ 

แบ่งแยกประเภทของข้อมูล เช่น ข้อความ ตัวเลข 

วันที่ และสูตรค�ำนวณแตกต่างกัน เพราะข้อมูลแต่ละ

ประเภทอาจน�ำไปใช้งานต่างกัน เช่น ตัวเลขต้องน�ำไป

ค�ำนวณ บวก ลบ คูณ หาร หาผลรวม แต่ตัวเลขแบบ

ข้อความแค่ใช้ในการแสดงผลอย่างเดียว 

การป้อนข้อมูลลงไปในเซลล์ของ Excel โดยปกติ

จะถูกต้ังค่าเอาไว้ตามประเภทข้อมูลอยู่แล้ว คุณก็

สามารถป้อนลงไปได้ตรงๆ แต่ยังมียังมีเทคนิคการ

ป้อนข้อมูลมากมายที่สามารถน�ำมาใช้งานได้ เพ่ือ

ให้การจัดการกับข้อมูลได้ง่ายและรวดเร็วมากย่ิงข้ึน 

ในบทน้ีจะรวมเทคนิคการป้อนข้อมูลและการจดัรูปแบบ 

ข้อมูลใน Excel หลายๆ แบบมาแนะน�ำ ลองน�ำไปใช้

ดูนะคะ

ปอ้นข้อมูล
Input Data

Lesson

01
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